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Introduction 

Welcome to Unit Standard 2785 v8 Create a computer spreadsheet to provide a solution for 
organisation use with Microsoft Word 2010. 
 
This book has been written using Microsoft Excel 2010 with Windows 7.  
 

Retrievable Exercise Files 
Some exercise files have been created for you to prevent time in keying in many exercises.  You 
can then open these files and use the features of Excel to manipulate and format text.   

A list of these files is shown on page viii and instructions for downloading these files from our 
web site are included on page ix. 
 

What you will learn 
In this course you will learn how to - 

 plan and create a spreadsheet for organisational use 

 apply formatting to the spreadsheets and create graphs 

 use functions, macros and data integrity 

 create and use a template 

 produce a simple end-user document 
 

How you will learn 
This book is divided into sections.  Each section page lists the learning outcomes for that 
section.  You will work through each section and do all exercises (or those instructed by your 
tutor).   

Revision theory is included at the end of the section followed by a Practice Assessment.  Our 
books include accumulation and consolidation of learning which carries across each section.   
 
After you have completed the book your tutor will give you the actual Unit Standard 
Assessment.   
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Word meaning boxes 
Sometimes you will see a box at the left side of the page of a line that has dotted underlining. 
This box will contain information to help you understand the meaning of the underlined word 
(or how that word is formed).  An example is shown below. 
 
Data can therefore be altered to re-calculate budgets and to forecast results using different 
sales figures.  Worksheets can be saved, opened and printed as required. 
 

Different Excel buttons 
Depending on the size of your Excel screen, buttons on the ribbon may vary to those shown in 
this book.  The icon with the word of that feature may show, or the icon only. 
 

For example, the Copy button in the Clipboard group on the Home tab may be displayed in 
either of the following ways. 

  OR   

The Symbol button can show as either - 

 OR  
 

Shortcut keys 
Shortcut keys are indicated in the left margin, usually the first time they are used.  An example 
follows. 

1 Click on the Save button  on the Quick Access Toolbar . 

2 Type a file name for your document then click on Save.  
 

Glossary 
Generally when a word(s) is first used that is a technical term or a word that you may not know 
that relates to an exercise, or a particular Excel 2010 feature, a description is given.  You will 
also see that such words are in bold.   

These terms are listed on each section page, an example is shown below.  Explanations are also 
included in the Glossary at the end of the book. 
 
 

 

forecast  
=  to 
calculate a 
future 
result  

Ctrl S 
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Icons used in this book 

This book contains icons to help guide you in your learning.   

The following list shows the icon and its meaning. 

 

 Learning Outcomes 
Learning Outcomes are displayed on the section page and describe what you will learn in that 
section. 

 
 

 EXERCISE 1 
These are the exercises that you are required to do.  Often there will be an introduction 
sentence to tell you what you will be doing in that exercise.   
 
 

These are notes for your information. 

 
 

 Revision 

This appears at the end of each section and contains theory revision questions relating to 
features learnt in that section. 
 
 

 Practice Assessment 

Each practice assessment covers consolidation of topics learnt in that section and provides 
practice for students prior to sitting the actual Unit Standard Assessment. 
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Exercise Files used in this book 

 
(Instructions are included on the following page for downloading retrievable files 

from our web site at www.cherylprice.co.nz) 
 
 

Names of files 

Active Sports Healthy Homes Ltd 

Albany Joinery for Charts Holiday Options 

Assets Music Machine  

Baxter Sports Outdoor Life - October 

Best Deals for Charts Paradise Beach Surf Club 

Box Up Supermarkets Premier Books 

Cheryl Price Invoice Recreational Magazines 

Computer Courses Sales Ranking 

Cookery and Gardening Book Sales Series 

Costello’s Product Sales Spartacus - Auckland 

Cycle Stuff Sales - January Spreadsheet Documents 

Davidsons Stock 

Day Tripper Te Kea Trading 

Fiji Landing Apartments Townsville Jan-Mar 

Flash Fill Wairau Office Equipment 

Garden Soils Ltd Walker and Grant Commission 

Hats Income Statement 
Workbook Security, Protection and 
Comments Notes-Excel 2010 
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Downloading Exercise Files 

The exercise files listed on the previous page can be downloaded from the Cheryl Price web 
site using the instructions below. 

Exercise files can be downloaded to My Documents folder OR SkyDrive.  However, for the 
purposes of this book we have specified My Documents as the folder for saving and opening 
files.  If you are using SkyDrive simply use the SkyDrive folder instead. 
 
 

  

  

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 Click in the Product Search box and type the number of 
this unit standard, as shown at the right. 

4 Click on     

5 Click on   

6 Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files – V8 Excel 2010  Free Download 

The File Download dialog box will display.   

7 a Click on then click on the Documents folder shown below at the 
left OR on SkyDrive shown below at the right. 

 

    

b Click on . 

8 a Click on .   

b Right click on the zipped exercise file and select Extract All.  Click on Extract.   

 A folder will be created containing the exercise files.  

c Delete the Compressed (zipped) Folder. 

US 2785 

US 2785 
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NZQA Outcomes and Evidence Requirements 

Unit Standard 2785 (Version 8) 
 

Title Create a computer spreadsheet to provide a solution for organisation use 

Level 3 Credits 5 

 

Purpose People credited with this unit standard are able to: plan and 
create a spreadsheet to provide a solution for organisation use; 
and create end-user documentation for the spreadsheet. 

 

Classification Computing > Generic Computing 

 

Available grade Achieved 

 

Entry information 

Recommended skills and 
knowledge 

Unit 2784, Create and use a computer spreadsheet to solve a 
problem, or demonstrate equivalent knowledge and skills. 

 
 
Explanatory notes 
 
1 Candidates are required to design and produce a spreadsheet that is suitable for an 

organisation to use within its everyday business.  The spreadsheet can be created as part 
of a candidate's work or in response to a scenario provided to, or created by, the 
candidate.  More than one active spreadsheet must be produced for the purposes of this 
assessment (two or more spreadsheets or one spreadsheet containing two or more 
worksheets, which solve at least two different problems), and each of these must contain 
macros.  Each spreadsheet must also be graphed.  At least two macros and two graphs 
are required to achieve the standard. 

 
2 A plan outlines a list of steps of how the requirements of the spreadsheet will be realised.  

The plan must include the specifications and/or features required by the spreadsheet to 
provide the solution.  The plan may be modified during the task and changes justified.  
Evidence of planning may be oral, written, and/or graphic. 

 Depending on the assessment context, the plan will include a list of steps and key 
milestone outcomes, and may include: 

 how resources such as time, expertise and materials (and finance, if appropriate) will be 
used to achieve the outcomes of each milestone; 

 how consultation with stakeholders will be carried out to ensure that all constraints and 
requirements are met. 
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3 Definitions 
 Organisation describes the context the spreadsheet is designed to operate in (e.g. 

businesses, clubs, not-for-profit organisations).  It does not define or limit the situations 
in which assessment evidence may be gathered. 

 A simple end-user document includes a short description of the purpose of the 
spreadsheet, how to access the spreadsheet template(s), and instructions for the 
spreadsheet’s use including macro commands.  The end-user document must use 
consistent font and layout, be legible, and should either avoid the use of undefined 
jargon or acronyms, or provide a glossary for these.  The document must be saved in a 
format that is accessible to users. 

 
4 Legislation relevant to this unit standard includes but is not limited to the: 
 Copyright Act 1994; 

Copyright (New Technologies) Amendment Act 2008; 
 Health and Safety in Employment Act 1992; 

and any subsequent amendments. 
 
5 An assessment resource to support computing unit standards (levels 1 to 4) can be 

found on the NZQA website at www.nzqa.govt.nz/asm. 
A specific clarification for assessing against unit standard 2785; and ‘The Computing 
Process - a clarification document’ can be found on the NZQA website. 

 

Outcomes and evidence requirements 

Outcome 1 

Plan a computer spreadsheet to provide a solution for organisation use. 

Range includes more than one active spreadsheet. 
 
Evidence requirements 

1.1 The plan identifies the requirements of the spreadsheet in terms of its purpose and 
target users. 

1.2 The plan outlines the specifications and requirements, including constraints and/or 
features to be met by the spreadsheet for it to provide a solution. 
Range includes but is not limited to – macro commands; 
 formatting – spreadsheet and graphs. 

 
Outcome 2 

Create the computer spreadsheet. 

Range includes more than one active spreadsheet. 
 
Evidence requirements 

2.1 Data is entered and is formatted to produce the spreadsheet required by the plan. 

Range formatting may include but is not limited to – column width, 
alignment, text, number formats. 
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2.2 Spreadsheet cell formulae, functions and processes are entered to produce the 
spreadsheet required by the plan. 

Range includes but is not limited to – time and/or date calculations; 
sorting; absolute cell referencing;  
a minimum of two of statistical, financial, and logical functions. 

2.3 Macro commands are created, tested and documented according to the 
requirements of the plan. 

2.4 A spreadsheet template is created, named and saved in format that will allow the 
spreadsheet to be retrieved and modified. 

2.5 Cell ranges within the spreadsheets are graphed according to the requirements of 
the plan. 

2.6 Data integrity practices are demonstrated by comparing original information 
sources, audited formulae and checking totals for accuracy. 

2.7 The spreadsheet is printed in hard copy and checked for appropriate formatting, 
readability, legibility, and presentation, and any required improvements are made. 

2.8 The final spreadsheet is confirmed as being fit for purpose in terms of meeting the 
purpose and requirements of the organisation as outlined in the plan. 

 
Outcome 3 

Create end-user documentation for the spreadsheet. 
 
Evidence requirements 

3.1 A simple end-user document is created to facilitate use of the spreadsheet. 
 

Planned review date 31 December 2016 

 
Status information and last date for assessment for superseded versions 

Process Version Date Last Date for Assessment 

Registration 1 30 September 1994 31 December 2013 

Review 2 24 September 1997 31 December 2013 

Revision 3 28 July 1998 31 December 2013 

Review 4 30 July 2002 31 December 2013 

Revision 5 16 July 2004 31 December 2013 

Review 6 22 May 2009 31 December 2013 

Revision 7 18 February 2011 31 December 2015 

Rollover and 
Revision 

8 19 September 2013 N/A 

 

Consent and Moderation Requirements (CMR) reference 0226 

 
This CMR can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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Format and Edit Worksheets 
Sheets 
Calculate with Dates and Times 

 
 

 

Section 1 revises some of the learning covered in the Cheryl Price book for US 2784, which is 
recommended prior learning for this unit.  Even if you have already attained US 2784, it is 
recommended that you work through this section.   

 
 

 Learning Outcomes 
 

At the end of this section you should be able to -  
 

 Format a worksheet 

 Preview and print a worksheet 

 Apply currency formats to data 

 Copy and move data using the Clipboard or mouse 

 Insert, delete, rename, move and copy sheets 

 Calculate with dates and times 

 

 
 
 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

Arguments 
Backstage View 
Dynamic 
Formula 
Functions 
Gridlines 

Justified 
Landscape Orientation 
Live Preview 
Margins 
Mini Toolbar 
Page Setup 

Parentheses 
Print Preview 
Shortcut Menu 
Vertically Aligned 

Section 

1 
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Formulas and Functions 

A formula  can include one or more functions  which are pre-defined calculations that are part 
of the Excel program. 

The basic syntax for a function is =FUNCTION NAME(arguments). The arguments are usually 
references to the cells containing the values that the function will use. 

Function names often give you an idea of what the function does, eg SUM adds up all the cells 
in a given range, while AVERAGE calculates the average amount in a given range of cells. 

Example:    =SUM(B5:D5)   

The SUM function has been used to add cells from B5 to D5. 

The colon (:) indicates an inclusive range of cells, in this example, B5 through D5. 

Parentheses 

If a formula includes more than one operation (eg multiplication and subtraction), Excel follows 
a strict “order of precedence” when it carries out a calculation. Exponentiation (using the ^ 
operator) is done first; then multiplication (*) and division (/); finally addition (+) and 
subtraction (-).   

If you want to override that sequence, you must put parentheses (ie brackets) around that part 
of the formula that you want done first.  Look at the following examples to see how parentheses 
can affect the result.   

 

Example 1: 

This example follows the standard sequence: the formula in cell E2 is =B2+C2/D2.  The division 
is done first, and the result of that added to the value in B2. 

Example 2: 

The formula in cell E3 is =(B2+C2)/D2. The addition is performed first because of the 
parentheses around that part of the formula.  The result of that is then divided by the value in 
D2. 
 

 EXERCISE 1 

 If you were to calculate the following sums in a worksheet taking into account the effect 
parentheses have on a calculation, what would the answers be? 

6+6+8/2 =   ...............................................  

(6+6+8)/2 =  .............................................    

syntax 
= structure 
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Fonts 

A font is an individual typeface design. Changing the font type and size allows you to emphasise 
areas in a worksheet.   
 
 

 
 
 

 
In addition to using the formatting buttons shown above, options can be changed in the Format 
Cells dialog box, where formatting changes can be previewed before applying them to cells.   

If you want to change the font and/or font size in your worksheet you should make use of the 
Live Preview feature which you will use in the next exercise. 
 

Format Cells, Font tab Dialog Box 
a) Select the cells to be formatted. 

b) Right-click on the selection and choose .  The Format Cells dialog box is 
displayed as shown below.  

 

Alternatively,  click on  in the Cells group on the Home tab, and choose 

. 

c) Click on the Font tab. 

d) Select the font, font style, size and any other formatting required. 

e) Click on OK. 

Ctrl 1 

Font Font Size 

Bold 
Italic 

Underline 

Font colour 

Align Left 
Centre 

Align Right 
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Mini Toolbar 
When you right click on selected cells, the Mini Toolbar will be displayed, as shown below.   

Formatting options can be selected from this toolbar.  

 

 In Excel 2010 individual words or characters in a cell can contain different formatting, eg 
Sale Prices - December 2013 

 To alter the default font for every workbook, click on the  tab, then on 

.  Select options from the Use this font:  and Font size:    as shown below. 

 

Click on OK. 
 

 
 

Formatting a Worksheet 

 EXERCISE 2 

1 Click on the  tab, then on Open.   

2 Double click the workbook called Wairau Office Equipment  

3 Right-click on cell A1.  A drop down menu appears as shown below.  

 

4 Choose .  The Format Cells dialog box is displayed.  

5 Click on the Font tab. 
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6 Apply the font called Impact and change the font size to 24 pt.   

7 Click on Bold in the Font style: box. 

8 Click on OK. 

Use the Formatting buttons on the ribbon to change fonts and effects as follows. 

9 Change the font for the subtitle in cell A2 to Franklin Gothic Book 12 pt. 

10 Click on cell A5.   

11 Click on the Bold button  and the Italic button . 

12 Format cells A10 and A11 to italic. 

13 Select cells A13 to D13 and apply bold. 

14 Apply bold to cell A26. 

The Formatting buttons on the ribbon are a quick and efficient method of applying fonts 
and formats. Features such as bold or italic can be turned on or off by clicking on the 
appropriate button.   

Alternatively, the Mini Toolbar can be used. 

15 Widen column A until all the text in cells A10 to A24 are displayed, ie position the mouse 
pointer between the column A and B header until the mouse pointer displays as a cross as 
shown below then drag to the right to widen (or to the left to decrease the width of the 
column).  A box will indicate the width of the column.   

 

An alternative method is to click within a column then click on  on the Home tab, 

select  and specify the width of the column (or selected columns).  
Default Width can be used to change all columns to a specified width. 

 

16 Save the workbook.  
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Borders and Patterns 

To add borders to a cell or a range of cells, you can use the Borders button  in the Font 
group on the Home tab.  
 

Borders Button 
When you click directly on the Borders button, the border shown on the button is applied to 
the selected cell(s).  

If you click on the  of the  button, you can select a different type of border from the 
displayed menu. 

 

A line style and colour can also be applied using the options displayed under the Draw Borders 
section of the menu. 
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Format Cells, Border tab Dialog Box 

 

a) Select the cells required and right-click on the selection. 

b) Choose and click on the Border tab in the Format Cells dialog box. 

c) Select the line style and line colour required in the Line section. 

d) Click on a preset button OR click on a Border button to apply a border.  To remove a 
border click on the relevant Border button to turn it off OR select None. 

e) Click on OK. 
 

Removing Borders 
Borders can be removed in several ways as described here. 

 Select the cells with the border style applied.  Click on the  of the  button and 

choose . 

 Select the cells with the border style applied and right click on the selection.  Choose 

.  Click on the Border tab in Format Cells.  Click on None.  Click on OK. 

 Select the cells with the border style applied.  Choose  in the Editing group on 

the Home tab. Choose  (remember this will also clear number formats 
and alignments). 

 Click on the  of the Borders button and choose .  This turns the mouse 
pointer into an eraser, so lines can now be removed by clicking on them with the mouse. 

 

 

Adding a Fill Colour 
A colour fill can be applied to cells using the Fill Colour button  in the Font group on the 
ribbon.  Select the cells, click on the down-arrow, and select the desired colour.   

 
 
  

Ctrl 1 

Border 
buttons 

Line 
Colour 

Line 
Style 

Sa
m

pl
e D

oc
um

en
t



8    SECTION 1 © Cherylprice.co.nz Limited 

Adding a Pattern 
Patterns can be applied to cells by selecting the cells, right clicking on the cells, choosing Format 
Cells from the menu, and selecting a Pattern Color and Pattern Style from the Fill tab in the 
Format Cells dialog box.   

 
 

 EXERCISE 3 

1 Use the Borders button  to apply border formats to the worksheet as indicated 
below. 

2 Apply fill colours using the Fill Colour button . 

3 Calculate the Total Cost for each item (Quantity x Price) in cells D14 to D24. 

4 Use  to calculate the Total in cell D26. 

5 Save the workbook. 
 

   

Top and Bottom 
Borders applied 
to cells 

Top and Double 
Bottom Border  
applied to cells 

Calculate the Total 
Cost column 

To apply the fancy 
border use the Format 
Cells dialog box, Border 
tab 

Apply a bright 
yellow fill colour 

Calculate using the 
AutoSum button 
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Alignment 

Aligning Data in a Cell 
Text entries are automatically aligned at the left of a cell, and number and formula entries at 
the right.  The alignment options shown below can be applied from the Alignment group on 
the Home tab.  

 Align Left  Center  Align Right 

 

The following diagram shows text to the left, centre, right and centred across merged cells. 

 
 

Aligning Across a Selection 
If you want text (eg a worksheet title) centred across the width of the data, select the 

appropriate cells and click on .  To undo the merge, select the merged cell 

and click on .  
 

Wrap Text  
The Wrap text option allows text to be wrapped onto two or more lines 
within a cell.  This can be turned on by selecting the cells required, 

choosing , choosing the Alignment tab, and placing a tick in the Wrap text 
check box.  Click on OK. 

To wrap text within a cell as you type, press Alt Enter where you want a new line to start. 

 

Indenting Text in a Cell 
Text in a cell can be indented.  An example is shown below. 

 

Indenting can be applied or removed using the Decrease Indent  and Increase Indent  
buttons in the Alignment group on the Home tab. 
  

Indented data 

indented 
=  move 
data to the 
right from 
the left cell 
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Vertical Alignment and Orientation 
Text can be vertically aligned at the top, bottom, centre, or justified in a cell.  Data can be 
displayed vertically or on an angle.  The diagram below shows the options available. 

 

Different types of alignment and orientation can be applied by selecting cells, choosing 

, and then selecting the Alignment tab as shown below. 

 
 

The Shrink to Fit option in the Alignment tab shrinks the font size of text so all the text is visible 
in a cell. 

 

 EXERCISE 4 

1 Select cells A1 to D1 and click on . 

2 Select cells A2 to D2 and press F4 (Repeat key) to repeat your last action. 

If cells A1 to D2 were selected, the cells would merge but the data in cell A2 would be lost, 
because only data in the first of the selected rows is retained. 

3 Right align the headings in cells B13 to D13. 

4 Select cells A13 to D13.   

5 Apply wrap text and vertical centre options using the Alignment tab in the Format Cells 
dialog box.  

6 In cell C13 change Price to Unit Price. 

7 Position the mouse pointer on the row header between rows 26 and 27.  The mouse 
pointer will change to a black cross.   

  

By dragging on the 
word Text you can 
change the angle at 
which text appears 
in a cell  

To set text on a 
specific angle, 
select the number 
of degrees required 

Aligns characters 
on top of each other 
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8 Click and drag downwards to the height of 21.00, as shown below.  

 

9 If necessary, select cells A26 to D26 and change the vertical alignment to centre.   

10 In cell A29 type: Thank you and press Ctrl Enter. 

11 In the Format Cells, Alignment tab dialog box, click and drag the word Text  
downwards in the Orientation box as shown below (-45 degrees).  

 

12 Click on OK.  The text is now on an angle in the cell. 

13 Set the alignment of the text back to horizontal, by dragging the word Text up to 0 
degrees.   

14 Click on OK.  

15 Make the amendments shown below.  

If text is not wrapped on the Unit Price heading, select cell C13, click at the end of the 
word Unit in the Formula bar, and press Alt Enter. 

 

16 Save the workbook. 

Merge cells and align 
the text at the top of 
the merged cell.  
Apply a border. 

Type the address by 
pressing Alt Enter to 
move to a new line. 

Type the Quotation 
Number. Sa
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Distributed (Indent) 
If Distributed (Indent) is selected from the Horizontal option in the Alignment tab,  text will be 
indented on the first line, justified, and the text will be wrapped in the cell.  

 
The second example shows the Left (Indent) option. 
 

Turning Off Gridlines 
Gridlines are automatically displayed in a worksheet but they can be turned off. 
 

 EXERCISE 5 
1 Click on the View tab on the ribbon. 

 

2 Click in the Gridlines check box to uncheck this option. 

The worksheet is displayed as shown below. 

 

3 Now turn gridlines on again. 
 

Even if they are not displayed, gridlines can be printed (see pages 16-17). 
 

 

Distributed 
(Indent) 

Left Indent 
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